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This page intentionally left blank Exploratory Network Analysis with Pajek 

This is the ï¬�rst textbook on social network analysis integrating theory, 

applications, and professional software for performing network analysis 

(Pajek). Step by step, the book introduces the main structural concepts and 

their applications in social research with exercises to test the understanding.

In each chapter, each theoretical section is followed by an application 

section explaining how to perform the network analyses with Pajek software. 

Pajek software and data sets for all examples are freely available, so the 

reader can learn network analysis by doing it. In addition, each chapter 

offers case studies for practicing network analysis. In the end, the reader has

the knowledge, skills, and tools to apply social network analysis in all social 

sciences, ranging from anthropology and sociology to business 

administration and history. Wouter de Nooy specializes in social network 

analysis and applications of network analysis to the ï¬�elds of literature, the

visual arts, music, and arts policy. His international publications have 

appeared in Poetics and Social Networks. He is Lecturer in methodology and 

sociology of the arts, Department of History and Arts Studies, Erasmus 

University, Rotterdam. Andrej Mrvar is assistant Professor of Social Science 

Informatics at the University of Ljubljana, Slovenia. He has won several 

awards for graph drawings at competitions between 1995 and 2000. He has 

edited Metodoloski zvezki since 2000. Vladimir Batagelj is Professor of 

Discrete and Computational Mathematics at the University of Ljubljana, 

Slovenia and is a member of the editorial boards of Informatica and Journal 

of Social Structure. He has authored several articles in Communications of 

ACM, Psychometrika, Journal of Classiï¬�cation, Social Networks, Discrete 

Mathematics, Algorithmica, Journal of Mathematical Sociology, Quality and 
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Quantity, Informatica, Lecture Notes in Computer Science, Studies in 

Classiï¬�cation, Data Analysis, and Knowledge Organization. Structural 

Analysis in the Social Sciences Mark Granovetter, editor The series Structural

Analysis in the Social Sciences presents approaches that explain social 

behavior and institutions by reference to relations among such concrete 

entities as persons and organizations. This contrasts with at least four other 

popular strategies: (a) reductionist attempts to explain by a focus on 

individuals alone; (b) explanations stressing the casual primacy of such 

abstract concepts as ideas, values, mental harmonies, and cognitive maps 

(thus, “ structuralism" on the Continent should be distinguished from 

structural analysis in the present sense); (c) technological and material 

determination; (d) explanation using “ variables" as the main analytic 

concepts (as in the “ structural equation" models that dominated much of 

the sociology of the 1970s), where structure is that connecting variables 

rather that actual social entities. The social network approach is an 

important example of the strategy of structural analysis; the series also 

draws on social science theory and research that is not framed explicitly in 

network terms, but stresses the importance of relations rather than the 

atomization of reduction or the determination of ideas, technology, or 

material conditions. Though the structural perspective has become 

extremely popular and inï¬‚ uential in all the social sciences, it does not 

have a coherent identity, and no series yet pulls together such work under a 

single rubric. By bringing the achievements of structurally oriented scholars 

to a wider public, the Structural Analysis series hopes to encourage the use 

of this very fruitful approach. Mark Granovetter Other Books in the Series 1. 

Mark S. Mizruchi and Michael Schwartz, eds., Intercorporate Relations: The 
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Structural Analysis of Business 2. Barry Wellman and S. D. Berkowitz, eds., 

Social Structures: A Network Approach 3. Ronald L. Brieger, ed., Social 

Mobility and Social Structure 4. David Knoke, Political Networks: The 

Structural Perspective 5. John L. Campbell, J. Rogers Hollingsworth, and Leon 

N. Lindberg, eds., Governance of the American Economy 6. Kyriakos 

Kontopoulos, The Logics of Social Structure 7. Philippa Pattison, Algebraic 

Models for Social Structure 8. Stanley Wasserman and Katherine Faust, 

Social Network Analysis: Methods and Applications 9. Gary Herrigel, 

Industrial Constructions: The Sources of German Industrial Power 10. Philippe

Bourgois, In Search of Respect: Selling Crack in El Barrio 11. Per Hage and 

Frank Harary, Island Networks: Communication, Kinship, and Classiï¬�cation

Structures in Oceana 12. Thomas Schweizer and Douglas R. White, eds., 

Kinship, Networks and Exchange 13. Noah E. Friedkin, A Structural Theory of 

Social Inï¬‚ uence 14. David Wank, Commodifying Communism: Business, 

Trust, and Politics in a Chinese City 15. Rebecca Adams and Graham Allan, 

Placing Friendship in Context 16. Robert L. Nelson and William P. Bridges, 

Legalizing Gender Inequality: Courts, Markets and Unequal Pay for Women in

America 17. Robert Freeland, The Struggle for Control of the Modern 

Corporation: Organizational Change at General Motors, 1924—1970 18. Yi-

min Lin, Between Politics and Markets: Firms, Competition, and Institutional 

Change in Post-Mao China 19. Nan Lin, Social Capital: A Theory of Social 

Structure and Action 20. Christopher Ansell, Schism and Solidarity in Social 

Movements: The Politics of Labor in the French Third Republic 21. Thomas 

Gold, Doug Guthrie, and David Wank, eds., Social Connections in China: 

Institutions, Culture, and the Changing Nature of Guanxi 22. Roberto 

Franzosi, From Words to Numbers 23. Sean O’Riain, Politics of High Tech 
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Growth 24. Michael Gerlach and James Lincoln, Japan’s Network Economy 25.

Patrick Doreian, Vladimir Batagelj, and AnuË‡ ka Ferligoj, Generalized Blocks 

modeling 26. Eiko Ikegami, Bonds of Civility: Aesthetic Networks and Political

Origins of Japanese Culture 27. Wouter de Nooy, Andrej Mrvar, and Vladimir 

Batagelj, Exploratory Network Analysis with Pajek Exploratory Network 

Analysis with Pajek WOUTER DE NOOY Erasmus University Rotterdam 

ANDREJ MRVAR University of Ljubljana VLADIMIR BATAGELJ University of 

Ljubljana ï�£ï�¡ï�ï�¢ï�²ï�©ï�¤ï�§ï�¥ 

ï�µï�®ï�©ï�¶ï�¥ï�²ï�³ï�©ï�´ï�¹ ï�°ï�²ï�¥ï�³ï�³ Cambridge, New 

York, Melbourne, Madrid, Cape Town, Singapore, SÃ£o Paulo Cambridge 

University Press The Edinburgh Building, Cambridge ï�£ï�¢ïœ² ïœ²ï�²ï�µ, 

UK Published in the United States of America by Cambridge University Press, 

New York www. cambridge. org Information on this title: www. cambridge. 

org/9780521841733 © Cambridge University Press 2005 This publication is 

in copyright. Subject to statutory exception and to the provision of relevant 

collective licensing agreements, no reproduction of any part may take place 

without the written permission of Cambridge University Press. First published

in print format 2005 ï�©ï�³ï�¢ï�®-ïœ±ïœ³ ï�©ï�³ï�¢ï�®-ïœ±ïœ° 

ï�©ï�³ï�¢ï�®-ïœ±ïœ³ ï�©ï�³ï�¢ï�®-ïœ±ïœ° ï�©ï�³ï�¢ï�®-ïœ±ïœ³ 

ï�©ï�³ï�¢ï�®-ïœ±ïœ° ïœ¹ïœ·ïœ¸-ïœ°-ïœµïœ±ïœ±-ïœ±ïœ²ïœ¶ïœ³ïœµ-ïœ² 

eBook (NetLibrary) ïœ°-ïœµïœ±ïœ±-ïœ±ïœ²ïœ¶ïœ³ïœµ-ïœ² eBook 

(NetLibrary) ïœ¹ïœ·ïœ¸-ïœ°-ïœµïœ²ïœ±-ïœ¸ïœ´ïœ±ïœ·ïœ³-ïœ³ hardback ïœ°-

ïœµïœ²ïœ±-ïœ¸ïœ´ïœ±ïœ·ïœ³-ïœ¹ hardback ïœ¹ïœ·ïœ¸-ïœ°-ïœµïœ²ïœ±-

ïœ¶ïœ°ïœ²ïœ¶ïœ²-ïœ´ paperback ïœ°-ïœµïœ²ïœ±-ïœ¶ïœ°ïœ²ïœ¶ïœ²-ïœ¹ 

paperback Cambridge University Press has no responsibility for the 

persistence or accuracy of ï�µï�²ï�¬s for external or third-party internet 
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websites referred to in this publication, and does not guarantee that any 

content on such websites is, or will remain, accurate or appropriate. To 

AnuË‡ ka, s who makes things happen Contents List of Illustrations List of 

Tables Preface Overview Justiï¬�cation Acknowledgments Part I — 

Fundamentals 1 Looking for Social Structure 1. 1 Introduction 1. 2 

Sociometry and Sociogram 1. 3 Exploratory Social Network Analysis 1. 3. 1 

Network Deï¬�nition 1. 3. 2 Manipulation 1. 3. 3 Calculation 1. 3. 4 

Visualization 1. 4 Assembling a Social Network 1. 5 Summary 1. 6 Questions 

1. 7 Assignment 1. 8 Further Reading 1. 9 Answers 2 Attributes and Relations

2. 1 Introduction 2. 2 Example: The World System 2. 3 Partitions 2. 4 

Reduction of a Network 2. 4. 1 Local View 2. 4. 2 Global View 2. 4. 3 

Contextual View 2. 5 Vectors and Coordinates 2. 6 Network Analysis and 

Statistics 2. 7 Summary 2. 8 Questions 2. 9 Assignment ix page xv xxi xxiii 

xxiii xxv xxvii 1 3 3 3 5 6 10 12 14 21 24 25 26 26 26 29 29 29 31 36 36 39 

41 43 48 51 52 53 x Contents 2. 10 Further Reading 2. 11 Answers Part II — 

Cohesion 3 Cohesive Subgroups 3. 1 Introduction 3. 2 Example 3. 3 Density 

and Degree 3. 4 Components 3. 5 Cores 3. 6 Cliques and Complete 

Subnetworks 3. 7 Summary 3. 8 Questions 3. 9 Assignment 3. 10 Further 

Reading 3. 11 Answers 4 Sentiments and Friendship 4. 1 Introduction 4. 2 

Balance Theory 4. 3 Example 4. 4 Detecting Structural Balance and 

Clusterability 4. 5 Development in Time 4. 6 Summary 4. 7 Questions 4. 8 

Assignment 4. 9 Further Reading 4. 10 Answers 5 Afï¬�liations 5. 1 

Introduction 5. 2 Example 5. 3 Two-Mode and One-Mode Networks 5. 4 m-

Slices 5. 5 The Third Dimension 5. 6 Summary 5. 7 Questions 5. 8 

Assignment 5. 9 Further Reading 5. 10 Answers Part III — Brokerage 6 Center

and Periphery 6. 1 Introduction 6. 2 Example 6. 3 Distance 6. 4 Betweenness 
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6. 5 Summary 6. 6 Questions 6. 7 Assignment 6. 8 Further Reading 6. 9 

Answers 53 54 59 61 61 61 62 66 70 73 77 79 81 82 82 84 84 84 87 88 92 

95 96 97 98 98 101 101 102 103 109 113 116 117 118 118 119 121 123 123

123 125 131 133 134 134 135 135 Contents 7 Brokers and Bridges 7. 1 

Introduction 7. 2 Example 7. 3 Bridges and Bi-Components 7. 4 Ego-Networks

and Constraint 7. 5 Afï¬�liations and Brokerage Roles 7. 6 Summary 7. 7 

Questions 7. 8 Assignment 7. 9 Further Reading 7. 10 Answers 8 Diffusion 8. 

1 Example 8. 2 Contagion 8. 3 Exposure and Thresholds 8. 4 Critical Mass 8. 

5 Summary 8. 6 Questions 8. 7 Assignment 8. 8 Further Reading 8. 9 

Answers Part IV — Ranking 9 Prestige 9. 1 Introduction 9. 2 Example 9. 3 

Popularity and Indegree 9. 4 Correlation 9. 5 Domains 9. 6 Proximity Prestige

9. 7 Summary 9. 8 Questions 9. 9 Assignment 9. 10 Further Reading 9. 11 

Answers 10 Ranking 10. 1 Introduction 10. 2 Example 10. 3 Triadic Analysis 

10. 4 Acyclic Networks 10. 5 Symmetric-Acyclic Decomposition 10. 6 

Summary 10. 7 Questions 10. 8 Assignment 10. 9 Further Reading 10. 10 

Answers 11 Genealogies and Citations 11. 1 Introduction 11. 2 Example I: 

Genealogy of the Ragusan Nobility 138 138 138 140 144 150 154 155 156 

157 158 161 161 163 167 173 178 179 180 181 181 185 187 187 188 189 

191 193 196 198 199 200 201 202 204 204 205 205 212 214 219 220 222 

222 223 226 226 226 xi xii Contents 11. 3 Family Trees 11. 4 Social 

Research on Genealogies 11. 5 Example II: Citations among Papers on 

Network Centrality 11. 6 Citations 11. 7 Summary 11. 8 Questions 11. 9 

Assignment 1 11. 10 Assignment 2 11. 11 Further Reading 11. 12 Answers 

Part V — Roles 12 Blockmodels 12. 1 Introduction 12. 2 Matrices and 

Permutation 12. 3 Roles and Positions: Equivalence 12. 4 Blockmodeling 12. 

4. 1 Blockmodel 12. 4. 2 Blockmodeling 12. 4. 3 Regular Equivalence 12. 5 
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Summary 12. 6 Questions 12. 7 Assignment 12. 8 Further Reading 12. 9 

Answers Appendix 1 — Getting Started with Pajek A1. 1 Installation A1. 2 

Network Data Formats A1. 3 Creating Network Files for Pajek A1. 3. 1 Within 

Pajek A1. 3. 2 Word Processor A1. 3. 3 Relational Database A1. 4 Limitations 

A1. 5 Updates of Pajek Appendix 2 — Exporting Visualizations A2. 1 Export 

Formats A2. 1. 1 Bitmap A2. 1. 2 Encapsulated PostScript A2. 1. 3 Scalable 

Vector Graphics A2. 1. 4 Virtual Reality Modeling Language A2. 1. 5 MDL MOL

and Kinemages A2. 2 Layout Options A2. 2. 1 Top Frame on the Left — 

EPS/SVG Vertex Default A2. 2. 2 Bottom Frame on the Left — EPS/SVG Line 

Default A2. 2. 3 Top Frame on the Right 227 233 242 243 250 251 252 252 

252 253 257 259 259 259 265 273 273 274 280 284 285 287 288 288 292 

292 292 294 294 295 298 302 302 303 303 303 303 305 306 307 308 309 

310 311 Contents A2. 2. 4 Middle Frame on the Right A2. 2. 5 Bottom Frame 

on the Right — SVG Default Appendix 3 — Shortcut Key Combinations Main 

Screen Hierarchy Edit Screen Draw Screen Glossary Index of Pajek 

Commands Subject Index 312 312 314 314 314 315 317 327 330 xiii 

Illustrations 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 

25 26 27 28 29 Dependencies between the chapters. page Sociogram of 

dining-table partners. Partial listing of a network data ï¬�le for Pajek. Pajek 

Main screen. Menu structure in Pajek. An information box in Pajek. Report 

screen in Pajek. Dialog box of Info> Network> General command. Draw 

screen in Pajek. Continue dialog box. A selected option in the Draw screen. 

Options menu of the Draw screen. Textual output from [Draw]Info> All 

Properties. A 3-D rendering of the dining-table partners network. Random 

network without lines. Edit Network screen. World trade of manufactures of 

metal and world system position. Edit screen with partition according to 
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world system position. Vertex colors according to a partition in Pajek. Trade 

ties within South America. The Partitions menu. World system positions in 

South America: (2) semiperiphery and (3) periphery. Trade in manufactures 

of metal among continents (imports in thousands of U. S. dollars). Trade 

among continents in the Draw screen. Contextual view of trade in South 

America. Geographical view of world trade in manufactures of metal, ca. 

1994. Info> Vector dialog box. Trade, position in the world system, and GDP 

per capita. Aggregate trade in manufactures of metal among world system 

positions. xv xxv 4 8 10 11 12 13 13 15 16 18 19 19 20 23 23 32 33 35 37 38

38 39 41 42 44 45 47 54 xvi Illustrations 30 Contextual view of North 

American trade ties and (mean) GDP per capita. 31 Visiting ties in Attiro. 32 

A simple unconnected directed network. 33 Strong components (contours) 

and family—friensdhip groupings (vertex colors and numbers) in the network

of Attiro. 34 k-Cores in the visiting network at Attiro. 35 k-Cores. 36 Stacking 

or nesting of k-cores. 37 The complete triad and an example. 38 A hierarchy 

of cliques. 39 Viewing a hierarchy in an Edit screen. 40 Complete triads and 

family—friendship groupings (colors and numbers inside vertices). 41 

Decision tree for the analysis of cohesive subgroups. 42 A Person-Other-

Object (X) triple. 43 P-O-X triple as a signed digraph. 44 A balanced network. 

45 First positive and negative choices between novices at T4. 46 Output 

listing of a Balance command. 47 Three solutions with one error. 48 Partial 

listing of Sampson. net. 49 Differences between two solutions with four 

classes. 50 A fragment of the Scottish directorates network. 51 One-mode 

network of ï¬�rms created from the network in Figure 50. 52 One-mode 

network of directors derived from Figure 50. 53 m-Slices in the network of 

Scottish ï¬�rms, 1904—5 (contours added manually). 54 2-Slice in the 
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network of Scottish ï¬�rms (1904—5) with industrial categories (class 

numbers) and capital (vertex size). 55 Partial view of m-slices in an SVG 

drawing. 56 m-Slices in three dimensions. 57 Coordinate system of Pajek. 58 

Communication ties within a sawmill. 59 Star- and line-networks. 60 

Distances to or from Juan (vertex colors: Default GreyScale 1). 61 Geodesics 

between HP-1 and EM-4. 62 Betweenness centrality in the sawmill. 63 

Communication network of striking employees. 64 Cut-vertices (gray) and bi-

components (manually circled) in the strike network. 65 Hierarchy of bi-

components and bridges in the strike network. 66 Three connected triads. 55

62 66 69 71 71 72 74 75 76 77 78 85 85 86 88 91 92 93 99 103 105 105 108

110 112 114 115 124 125 129 130 132 139 141 144 145 Illustrations 67 68 

69 70 71 72 73 74 75 76 77 Alejandro’s ego-network. Proportional strength 

of ties around Alejandro. Constraints on Alejandro. Energized constraint 

network. Five brokerage roles of actor v. Bob’s ego-network. Constraint 

inside groups. Two overlapping cliques. Friendship ties among 

superintendents and year of adoption. Adoption of the modern math method:

diffusion curve. Diffusion by contacts in a random network (N = 100, vertex 

numbers indicate the distance from the source vertex). Diffusion from a 

central and a marginal vertex. Adoption (vertex color) and exposure (in 

brackets) at the end of 1959. Modern math network with arcs pointing 

toward later adopters. Visiting ties and prestige leaders in San Juan Sur. 

Partitions menu in Pajek. Distances to family 47 (represented by the 

numbers within the vertices). Proximity prestige in a small network. Student 

government discussion network. An example of a network with ranks. Triad 

types with their sequential numbers in Pajek. Strong components in the 

student government discussion network. Acyclic network with shrunk 
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components. Clusters of symmetric ties in the student government network. 

Discussion network shrunk according to symmetric clusters. Symmetric 

components in the (modiï¬�ed) student government discussion network. 

The order of symmetric clusters acording to the depth partition (acyclic). 

Ranks in the student government discussion network. Three generations of 

descendants to Petrus Gondola (years of birth). Ore graph. Descendants of 

Petrus Gondola and Ana Goce. Shortest paths between Paucho and Margarita

Gondola. Structural relinking in an Ore graph. P-graph. Structual relinking in 

a P-graph. Fragment of relinking grandchildren. 146 147 147 149 151 152 

153 157 162 164 xvii 78 79 80 81 82 83 84 85 86 87 88 89 90 91 92 93 94 

95 96 97 98 99 100 101 102 165 165 168 172 188 192 194 197 205 206 207

213 214 215 216 216 218 218 228 229 231 231 235 236 236 239 xviii 

Illustrations 103 Centrality literature network in layers according to year of 

publication. 104 k-Cores in the centrality literature network (without 

isolates). 105 Traversal weights in a citation network. 106 A main path in the

centrality literature network. 107 Main path component of the centrality 

literature network (not all names are shown here). 108 Communication lines 

among striking employees. 109 The matrix of the strike network sorted by 

ethnic and age groups. 110 A network and a permutation. 111 Partial listing 

of the strike network as a binary matrix. 112 The strike network permuted 

according to ethnic and age groups. 113 Part of the permuted strike network 

displayed as a binary network. 114 Hypothetical ties among two instructors 

(i) and three students (s). 115 A dendrogram of similarities. 116 Imports of 

miscellaneous manufactures of metal and world system position in 1980. 117

Hierarchical clustering of the world trade network. 118 Hierarchical 

clustering of countries in the Hierarchy Edit screen. 119 An ideal core-
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periphery structure. 120 Image matrix and shrunk network. 121 Error in the 

imperfect core-periphery matrix. 122 Optimize Partition dialog box. 123 

Output of the Optimize Partition procedure. 124 Random Start dialog box. 

125 Matrix of the student government network. 126 Image matrix and error 

matrix for the student government network. 127 Assembling a blockmodel in

Pajek. 128 Read Network dialog box. 129 A network in Pajek matrix format. 

130 Editing vertex labels. 131 Edit Network screen. 132 An empty network in

Pajek Arcs/Edges format. 133 A network in the Pajek Arcs/Edges format. 134 

A network in the Pajek matrix format. 135 A two-mode network in the Pajek 

Arcs/Edges format. 136 Four tables in the world trade database (MS Access 

97). 137 Contents of the Countries table (partial). 138 A Lookup to the 

Countries table. 139 Export a report to plain text. 140 Tables and relations in

the database of Scottish companies. 243 245 246 248 249 260 261 262 263 

264 264 265 267 268 270 271 273 274 275 277 278 279 280 281 283 293 

293 294 295 296 296 297 297 298 298 299 300 301 Illustrations 141 142 

143 144 145 The Options screen. Layout of a vertex and its label. The x/y 

ratio of a vertex. The position and orientation of a line label. Gradients in 

SVG export: linear (left) and radial (right). 308 309 310 311 312 xix Tables 1 

2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 Tabular 

output of the command Info> Partition. Distribution of GNP per capita in 

classes. Output of the Info command. Cross-tabulation of world system 

positions (rows) and GDP per capita (columns). Frequency distribution of 

degree in the symmetrized network of visits. Error score with all choices at 

different moments (Î± = . 5). Error score with ï¬�rst choices only (Î± = . 5). 

Line multiplicity in the one-mode network of ï¬�rms. Frequency tabulation 

of coordinator roles in the strike network. Adoption in the modern math 
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network. Adoption rate and acceleration in the modern math diffusion curve. 

Fragment of Table 11. Indegree listing in Pajek. Input domain of f47. Size of 

input domains in the visiting relations network. Balance-theoretic models. 

Triad census of the example network. Triad census of the student 

government network. Number of children of Petrus Gondola and his male 

descendants. Size of sibling groups in 1200—1250 and 1300—1350. Birth 

cohorts among men and women. Traversal weights in the centrality literature

network. Dissimilarity scores in the example network. Cross-tabulation of 

initial (rows) and optimal partition (columns). Final image matrix of the world

trade network. Names of colors in Pajek. page 34 45 50 56 65 95 99 107 154

167 174 177 190 195 196 209 210 212 233 234 240 248 266 278 279 309 

xxi Preface In the social sciences, social network analysis has become a 

powerful methodological tool alongside statistics. Network concepts have 

been deï¬�ned, tested, and applied in research traditions throughout the 

social sciences, ranging from anthropology and sociology to business 

administration and history. This book is the ï¬�rst textbook on social 

network analysis integrating theory, applications, and professional software 

for performing network analysis. It introduces structural concepts and their 

applications in social research with exercises to improve skills, questions to 

test the understanding, and case studies to practice network analysis. In the 

end, the reader has the knowledge, skills, and tools to apply social network 

analysis. We stress learning by doing: readers acquire a feel for network 

concepts by applying network analysis. To this end, we make ample use of 

professional computer software for network analysis and visualization: Pajek.

This software, operating under Windows 95 and later, and all example data 

sets are provided on a Web site (http://vlado. fmf. uni-lj. si/pub/ 
https://assignbuster.com/pajek/
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networks/book/) dedicated to this book. All the commands that are needed to

produce the graphical and numerical results presented in this book are 

extensively discussed and illustrated. Step by step, the reader can perform 

the analyses presented in the book. Note, however, that the graphical 

display on a computer screen will never exactly match the printed ï¬�gures 

in this book. After all, a book is not a computer screen. Furthermore, newer 

versions of the software will appear, with features that may differ from the 

descriptions presented in this book. We strongly advise using the version of 

Pajek software supplied on the book’s Web site (http://vlado. fmf. uni-lj. 

si/pub/networks/book/) while studying this book and then updating to a 

newer version of Pajek afterwards, which can be downloaded from 

http://vlado. fmf. unilj. si/pub/networks/pajek/default. htm. Overview This 

book contains ï¬�ve sections. The ï¬�rst section (Part I) presents the basic 

concepts of social network analysis. The next three sections present the 

three major research topics in social network analysis: cohesion xxiii xxiv 

Preface (Part II), brokerage (Part III), and ranking (Part IV). We claim that all 

major applications of social network analysis in the social sciences relate to 

one or more of these three topics. The ï¬�nal section discusses an 

advanced technique (viz., blockmodeling), which integrates the three 

research topics (Part V). The ï¬�rst section, titled Fundamentals, introduces 

the concept of a network, which is obviously the basic object of network 

analysis, and the concepts of a partition and a vector, which contain 

additional information on the network or store the results of analyses. In 

addition, this section helps the reader get started with Pajek software. Part II 

on cohesion consists of three chapters, each of which presents measures of 

cohesion in a particular type of network: ordinary networks (Chapter 3), 
https://assignbuster.com/pajek/
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signed networks (Chapter 4), and valued networks (Chapter 5). Networks 

may contain different types of relations. The ordinary network just shows 

whether there is a tie between people, organizations, or countries. In 

contrast, signed networks are primarily used for storing relations that are 

either positive or negative such as affective relations: liking and disliking. 

Valued networks take into account the strength of ties, for example, the total

value of the trade from one country to another or the number of directors 

shared by two companies. Part III on brokerage focuses on social relations as

channels of exchange. Certain positions within the network are heavily 

involved in the exchange and ï¬‚ ow of information, goods, or services, 

whereas others are not. This is connected to the concepts of centrality and 

centralization (Chapter 6) or brokers and bridges (Chapter 7). Chapter 8 

discusses an important application of these ideas, namely the analysis of 

diffusion processes. The direction of ties (e. g., who initiates the tie) is not 

very important in the section on brokerage, but it is central to ranking, 

presented in Part IV. Social ranking, it is assumed, is connected to 

asymmetric relations. In the case of positive relations, such as friendship 

nominations or advice seeking, people who receive many choices and 

reciprocate few choices are deemed as enjoying more prestige (Chapter 9). 

Patterns of asymmetric choices may reveal the stratiï¬�cation of a group or 

society into a hierarchy of layers (Chapter 10). Chapter 11 presents a 

particular type of asymmetry, namely the asymmetry in social relations 

caused by time: genealogical descent and citation. The ï¬�nal section, Part 

V, on roles, concentrates on rather dense and small networks. This type of 

network can be visualized and stored efï¬�ciently by means of matrices. 

Blockmodeling is a suitable technique for analyzing cohesion, brokerage, and
https://assignbuster.com/pajek/
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ranking in dense, small networks. It focuses on positions and social roles 

(Chapter 12). The book is intended for researchers and managers who want 

to apply social network analysis and for courses on social network analysis in

all social sciences as well as other disciplines using social methodology (e. 

g., history and business administration). Regardless of the context in which 

the book is used, Chapters 1, 2, and 3 must be studied to understand the 

topics of subsequent chapters and the logic of Pajek. Chapters 4 and 5 may 

be skipped if the researcher or student is not interested in networks Preface 

Ch. 5 - Affiliations Ch. 11 - Genealogies and citations Ch. 9 - Prestige Ch. 10 - 

Ranking Ch. 2 - Attributes and relations Ch. 1 - Looking for social structure 

Ch. 3 - Cohesive subgroups Ch. 6 - Center and periphery Ch. 7 - Brokers and 

bridges Ch. 8 - Diffusion Ch. 4 - Sentiments and friendship Ch. 12 - 

Blockmodels xxv Figure 1. Dependencies between the chapters. with signed 

or valued relations, but we strongly advise including them to be familiar with 

these types of networks. In Parts III (Brokerage) and IV (Ranking), the ï¬�rst 

two chapters present basic concepts and the third chapter focuses on 

particular applications. Figure 1 shows the dependencies among the 

chapters of this book. To study a particular chapter, all preceding chapters in

this ï¬‚ ow chart must have been studied before. Chapter 10, for instance, 

requires understanding of Chapters 1 through 4 and 9. Within the chapters, 

there are not sections that can be skipped. In an undergraduate course, Part 

I and II should be included. A choice can be made between Part III and Part IV

or, alternatively, just the ï¬�rst chapter from each section may be selected. 

Part V on social roles and blockmodeling is quite advanced and more 

appropriate for a postgraduate course. For managerial purposes, Part III is 

probably more interesting than Part IV. Justiï¬�cation This book offers an 
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introduction to social network analysis, which implies that it covers a limited 

set of topics and techniques, which we feel a beginner must master to be 

able to ï¬�nd his or her way in the ï¬�eld of social network analysis. We 

have made many decisions about what to include and what to exclude and 

we want to justify our choices now. As reï¬‚ ected in the title of this book, we

restrict ourselves to exploratory social network analysis. The testing of 

hypotheses by means of statistical models or Monte Carlo simulations falls 

outside the scope of this book. In social network analysis, hypothesis testing 

is important but complicated; it deserves a book on its own. Aiming our book 

at people who are new to social network analysis, our ï¬�rst priority is to 

have them explore the structure of social networks to give them a feel for 

the concepts and applications of network analysis. Exploration involves 

visualization and manipulation of concrete networks, whereas hypothesis 

testing boils down to numbers representing abstract parameters and 

probabilities. In xxvi Preface our view, exploration yields the intuitive 

understanding of networks and basic network concepts that are a 

prerequisite for well-considered hypothesis testing. From the vast array of 

network analytic techniques and indices we discuss only a few. We have no 

intention of presenting a survey of all structural techniques and indices 

because we fear that the readers will not be able to see the forest for the 

trees. We focus on as few techniques and indices as are needed to present 

and measure the underlying concept. With respect to the concept of 

cohesion, for instance, many structural indices have been proposed for 

identifying cohesive groups: n-cliques, n-clans, n-clubs, m-cores, k-cores, k-

plexes, lambda sets, and so on. We discuss only components, k-cores, 3-

cliques, and m-slices (m-cores) because they sufï¬�ce to explain the basic 
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parameters involved: density, connectivity, and strength of relations within 

cohesive subgroups. Our choice is inï¬‚ uenced by the software that we use 

because we have decided to restrict our discussion to indices and techniques

that are incorporated in this software. Pajek software is designed to handle 

very large networks (up to millions of vertices). Therefore, this software 

package concentrates on efï¬�cient routines, which are capable of dealing 

with large networks. Some analytical techniques and structural indices are 

known to be inefï¬�cient (e. g., the detection of n-cliques), and for others 

no efï¬�cient algorithm has yet been found or implemented. This limits our 

options: we present only the detection of small cliques (of size 3) and we 

cannot extensively discuss an important concept such as k-connectivity. In 

summary, this book is neither a complete catalogue of network analytic 

concepts and techniques nor an exhaustive manual to all commands of 

Pajek. It offers just enough concepts, techniques, and skills to understand 

and perform all major types of social network analysis. In contrast to some 

other handbooks on social network analysis, we minimize mathematical 

notation and present all deï¬�nitions verbatim. There are no mathematical 

formulae in the book. We assume that many students and researchers are 

interested in the application of social network analysis rather than in its 

mathematical properties. As a consequence, and this may be very surprising 

to seasoned network analysts, we do not introduce the matrix as a data 

format and display format for social networks until the end of the book. 

Finally, there is a remark on the terminology used in the book. Social 

network analysis derives its basic concepts from mathematical graph theory.

Unfortunately, different “ vocabularies" exist within graph theory, using 

different concepts to refer to the same phenomena. Traditionally, social 
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network analysts have used the terminology employed by Frank Harary, for 

example, in his book Graph Theory (Reading, Addison-Wesley, 1969). We 

choose, however, to follow the terminology that prevails in current textbooks

on graph theory, for example, R. J. Wilson’s Introduction to Graph Theory 

(Edinburgh, Oliver and Boyd, 1972; published later by Wiley, New York). 

Thus, we hope to narrow the terminological gap between social network 

analysis and graph theory. As a result, we speak of a vertex instead of a 

node or a point and some of our deï¬�nitions and concepts differ from those

proposed by Frank Harary. Preface xxvii Acknowledgments The text of this 

book has beneï¬�ted from the comments and suggestions from our 

students at the University of Ljubljana and the Erasmus University 

Rotterdam, who were the ï¬�rst to use it. In addition, Michael Frishkopf and 

his students of musicology at the University of Alberta gave us helpful 

comments. Mark Granovetter, who welcomed this book to his series, and his 

colleague Sean Farley Everton have carefully read and commented on the 

chapters. In many ways, they have helped us make the book more coherent 

and understandable to the reader. We are also very grateful to an 

anonymous reviewer, who carefully scrutinized the book and made many 

valuable suggestions for improvements. Ed Parsons (Cambridge University 

Press) and Nancy Hulan (TechBooks) helped us through the production 

process. Finally, we thank the participants of the workshops we conducted at

the XXIInd and XXIIIrd Sunbelt International Conference on Social Network 

Analysis in New Orleans and Cancun for their encouraging reactions to our 

manuscript. Most data sets that are used in this book have been created 
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used and distributed freely, we have tried to trace the authors of these 

articles and books and ask for their approval. We are grateful to have 

obtained explicit permission for using and distributing the data sets from 

them. Authors or their representatives whom we have not reached are 

invited to contact us. Part I Fundamentals Social network analysis focuses on

ties among, for example, people, groups of people, organizations, and 

countries. These ties combine to form networks, which we will learn to 

analyze. The ï¬�rst part of the book introduces the concept of a social 

network. We discuss several types of networks and the ways in which we can

analyze them numerically and visually with the computer software program 

Pajek, which is used throughout this book. After studying Chapters 1 and 2, 

you should understand the concept of a social network and you should be 

able to create, manipulate, and visualize a social network with the software 

presented in this book. 1 1 Looking for Social Structure 1. 1 Introduction The 

social sciences focus on structure: the structure of human groups, 

communities, organizations, markets, society, or the world system. In this 

book, we conceptualize social structure as a network of social ties. Social 

network analysts assume that interpersonal ties matter, as do ties among 

organizations or countries, because they transmit behavior, attitudes, 

information, or goods. Social network analysis offers the methodology to 

analyze social relations; it tells us how to conceptualize social networks and 

how to analyze them. In this book, we present the most important methods 

of exploring social networks, emphasizing visual exploration. Network 

visualization has been an important tool for researchers from the very 

beginning of social network analysis. This chapter introduces the basic 

elements of a social network and shows how to construct and draw a social 
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network. 1. 2 Sociometry and Sociogram The basis of social network 

visualization was laid by researchers who called themselves sociometrists. 

Their leader, J. L. Moreno, founded a social science called sociometry, which 

studies interpersonal relations. Society, they argued, is not an aggregate of 

individuals and their characteristics, as statisticians assume, but a structure 

of interpersonal ties. Therefore, the individual is not the basic social unit. The

social atom consists of an individual and his or her social, economic, or 

cultural ties. Social atoms are linked into groups, and, ultimately, society 

consists of interrelated groups. From their point of view, it is understandable 

that sociometrists studied the structure of small groups rather than the 

structure of society at large. In particular, they investigated social choices 

within a small group. They asked people questions such as, “ Whom would 

you choose as a friend [colleague, advisor, etc.]? " This type of data has 

since been known as sociometric choice. In sociometry, social choices are 

considered the most important expression of social relations. 3 4 Exploratory

Network Analysis with Pajek Louise 2 2 1 2 1 2 1 Ada 1 Lena Adele 1 Marion 

2 1 2 2 1 1 2 2 Jane Cora 2 2 2 1 Frances 1 Maxine 2 1 1 2 1 1 Mary 1 Eva 1 2

Edna Anna Ruth 1 Martha 1 2 2 1 2 Betty 2 2 Jean 1 1 Robin 2 Alice Helen 

Laura 1 2 2 1 Hazel 1 2 Ellen 2 1 Hilda Ella 2 1 Irene Figure 2. Sociogram of 

dining-table partners. Figure 2 presents an example of sociometric research. 

It depicts the choices of twenty-six girls living in one “ cottage" (dormitory) 

at a New York state training school. The girls were asked to choose the girls 

they liked best as their dining-table partners. First and second choices are 

selected only. (Here and elsewhere, a reference on the source of the data 

can be found under Further Reading, which is at the end of each chapter.) 

Figure 2 is an example of a sociogram, which is a graphical representation of
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group structure. The sociogram is among the most important instruments 

originated in sociometry, and it is the basis for the visualization of social 

networks. You have most likely already “ read" and understood the ï¬�gure 

without needing the following explanation, which illustrates its visual appeal 

and conceptual clarity. In this sociogram, each girl in the dormitory is 

represented by a circle. For the sake of identiï¬�cation, the girls’ names are

written next to the circles. Each arc (arrow) represents a choice. The girl who

chooses a peer as a dining-table companion sends an arc toward her. Irene 

(in the bottom right of the ï¬�gure), for instance, chose Hilda as her favorite

dining-table partner and Ellen as her second choice, as indicated by the 

numbers labeling each arrow. A sociogram depicts the structure of ties 

within a group. This example shows not only which girls are popular, as 

indicated by the number of choices they receive, but also whether the 

choices come from popular or unpopular girls. For example, Hilda receives 

four choices from Irene, Ruth, Hazel, and Betty, and she reciprocates the last

two choices. But none of these four girls is chosen by any of the other girls. 

Therefore, Hilda is located at the margin of the sociogram, whereas Frances, 

who is chosen only twice, is more central because she is chosen by “ 

popular" girls such as Adele and Marion. A simple count of choices does not 

reveal this, whereas a sociogram does. Looking for Social Structure The 

sociogram has proved to be an important analytical tool that helped to 

reveal several structural features of social groups. In this book, we make 

ample use of it. 5 1. 3 Exploratory Social Network Analysis Sociometry is not 

the only tradition in the social sciences that focuses on social ties. Without 

going into historical detail (see Further Reading for references on the history 

of social network analysis), we may note that scientists from several social 
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sciences have applied network analysis to different kinds of social relations 

and social units. Anthropologists study kinship relations, friendship, and gift 

giving among people rather than sociometric choice; social psychologists 

focus on affections; political scientists study power relations among people, 

organizations, or nations; economists investigate trade and organizational 

ties among ï¬�rms. In this book, the word actor refers to a person, 

organization, or nation that is involved in a social relation. We may say that 

social network analysis studies the social ties among actors. The main goal 

of social network analysis is detecting and interpreting patterns of social ties 

among actors. This book deals with exploratory social network analysis only. 

This means that we have no speciï¬�c hypotheses about the structure of a 

network beforehand that we can test. For example, a hypothesis on the 

diningtable partners network could predict a particular rate of mutual 

choices (e. g., one of ï¬�ve choices will be reciprocated). This hypothesis 

must be grounded in social theory and prior research experience. The 

hypothesis can be tested provided that an adequate statistical model is 

available. We use no hypothesis testing here, because we cannot assume 

prior research experience in an introductory course book and because the 

statistical models involved are complicated. Therefore, we adopt an 

exploratory approach, which assumes that the structure or pattern of ties in 

a social network is meaningful to the members of the network and, hence, to

the researcher. Instead of testing prespeciï¬�ed structural hypotheses, we 

explore social networks for meaningful patterns. For similar reasons, we pay 

no attention to the estimation of network features from samples. In network 

analysis, estimation techniques are even more complicated than estimation 

in statistics, because the structure of a random sample seldom matches the 
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structure of the overall network. It is easy to demonstrate this. For example, 

select ï¬�ve girls from the diningtable partners network at random and 

focus on the choices among them. You will ï¬�nd fewer choices per person 

than the two choices in the overall network for the simple reason that 

choices to girls outside the sample are neglected. Even in this simple 

respect, a sample is not representative of a network. 6 Exploratory Network 

Analysis with Pajek We analyze entire networks rather than samples. 

However, what is the entire network? Sociometry assumes that society 

consists of interrelated groups, so a network encompasses society at large. 

Research on the socalled Small World problem suggested that ties of 

acquaintanceship connect us to almost every human being on the earth in 

six or seven steps, (i. e., with ï¬�ve or six intermediaries), so our network 

eventually covers the entire world population, which is clearly too large a 

network to be studied. Therefore, we must use an artiï¬�cial criterion to 

delimit the network we are studying. For example, we may study the girls of 

one dormitory only. We do not know their preferences for table partners in 

other dormitories. Perhaps Hilda is the only vegetarian in a group of 

carnivores and she prefers to eat with girls of other dormitories. If so, 

including choices between members of different dormitories will alter Hilda’s 

position in the network tremendously. Because boundary speciï¬�cation 

may seriously affect the structure of a network, it is important to consider it 

carefully. Use substantive arguments to support your decision of whom to 

include in the network and whom to exclude. Exploratory social network 

analysis consists of four parts: the deï¬�nition of a network, network 

manipulation, determination of structural features, and visual inspection. In 

the following subsections we present an overview of these techniques. This 
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overview serves to introduce basic concepts in network analysis and to help 

you get started with the software used in this book. 1. 3. 1 Network 

Deï¬�nition To analyze a network, we must ï¬�rst have one. What is a 

network? Here, and elsewhere, we use a branch of mathematics called graph

theory to deï¬�ne concepts. Most characteristics of networks that we 

introduce in this book originate from graph theory. Although this is not a 

course in graph theory, you should study the deï¬�nitions carefully to 

understand what you are doing when you apply network analysis. 

Throughout this book, we present deï¬�nitions in text boxes to highlight 

them. A graph is a set of vertices and a set of lines between pairs of vertices.

What is a graph? A graph represents the structure of a network; all it needs 

for this is a set of vertices (which are also called points or nodes) and a set of

lines where each line connects two vertices. A vertex (singular of vertices) is 

the smallest unit in a network. In social network analysis, it represents an 

actor (e. g., a girl in a dormitory, an organization, or a country). A vertex is 

usually identiï¬�ed by a number. A line is a tie between two vertices in a 

network. In social network analysis it can be any social relation. A line is 

deï¬�ned by its two endpoints, which are the two vertices that are incident 

with the line. A loop is a special kind of line, namely, a line that connects a 

vertex to itself. In the dining-table partners network, loops do not occur 

Looking for Social Structure because girls are not allowed to choose 

themselves as a dinner-table partner. However, loops are meaningful in 

some kinds of networks. A line is directed or undirected. A directed line is 

called an arc, whereas an undirected line is an edge. Sociometric choice is 

best represented by arcs, because one girl chooses another and choices 

need not be reciprocated (e. g., Ella and Ellen in Figure 2). A directed graph 
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or digraph contains one or more arcs. A social relation that is undirected (e. 

g., is family of) is represented by an edge because both individuals are 

equally involved in the relation. An undirected graph contains no arcs: all of 

its lines are edges. Formally, an arc is an ordered pair of vertices in which 

the ï¬�rst vertex is the sender (the tail of the arc) and the second the 

receiver of the tie (the head of the arc). An arc points from a sender to a 

receiver. In contrast, an edge, which has no direction, is represented by an 

unordered pair. It does not matter which vertex is ï¬�rst or second in the 

pair. We should note, however, that an edge is usually equivalent to a 

bidirectional arc: if Ella and Ellen are sisters (undirected), we may say that 

Ella is the sister of Ellen and Ellen is the sister of Ella (directed). It is 

important to note this, as we will see in later chapters. The dining-table 

partners network has no multiple lines because no girl was allowed to 

nominate the same girl as ï¬�rst and second choice. Without this 

restriction, which was imposed by the researcher, multiple arcs could have 

occurred, and they actually do occur in other social networks. In a graph, 

multiple lines are allowed, but when we say that a graph is simple, we 

indicate that it has no multiple lines. In addition, a simple undirected graph 

contains no loops, whereas loops are allowed in a simple directed graph. It is 

important to remember this. A simple undirected graph contains neither 

multiple edges nor loops. A simple directed graph contains no multiple arcs. 

Now that we have discussed the concept of a graph at some length, it is very

easy to deï¬�ne a network. A network consists of a graph and additional 

information on the vertices or lines of the graph. We should note that the 

additional information is irrelevant to the structure of the network because 

the structure depends on the pattern of ties. A network consists of a graph 
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and additional information on the vertices or the lines of the graph. In the 

dining-table partners network, the names of the girls represent additional 

information on the vertices that turns the graph into a network. Because of 

this information, we can see which vertex identiï¬�es Ella in the sociogram. 

The numbers printed near the arcs and edges offer additional information on 

the links between the girls: a 1 indicates a ï¬�rst choice and a 2 represents 

a second choice. They are called line values, and they usually indicate the 

strength of a relation. 7 8 Exploratory Network Analysis with Pajek The 

dining-table partners network is clearly a network and not a graph. It is a 

directed simple network because it contains arcs (directed) but not multiple 

arcs (simple). In addition, we know that it contains no loops. Several 

analytical techniques we discuss assume that loops and multiple lines are 

absent from a network. However, we do not always spell out these properties

of the network but rather indicate whether it is simple. Take care! 

Application In this book, we learn social network analysis by doing it. We use 

the computer program Pajek — Slovenian for spider — to analyze and draw 

social networks. The Web site dedicated to this book (http://vlado. fmf. unilj. 

si/pub/networks/book/) contains the software. We advise you to download 

and install Pajek on your computer (see Appendix 1 for more details) and all 

example data sets from this Web site. Store the software and data sets on 

the hard disk of your computer following the guidelines provided on the Web 

site. When you have done so, carry out the commands that we discuss under

“ Application" in each chapter. This will familiarize you with the structural 

concepts and with Pajek. By following the instructions under “ Application" 

step by step, you will be able to produce the ï¬�gures and results presented

in the theoretical sections unless stated differently. Sometimes, the 
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visualizations on your computer screen will be slightly different from the 

ï¬�gures in the book. If the general patterns match, however, you know 

that you are on the right track. Some concepts from graph theory are the 

building blocks or data objects of Pajek. Of course, a network is the most 

important data object in Pajek, so let us describe it ï¬�rst. In Pajek, a 

network is deï¬�ned in accordance with graph theory: a list of vertices and 

lists of arcs and edges, where each arc or edge has a value. Take a look at 

the partial listing of the data ï¬�le for the dining-table partners network 

(Figure 3, note that part of the vertices and arcs are replaced by [ . . . ]). 

Open the ï¬�le Dining-table_ partners. net, which you have downloaded 

from the Web site, in a word processor program to see the entire data ï¬�le.

*Vertices 26 1 " Ada" 2 " Cora" 3 " Louise" 4 " Jean" […] 25 " Laura" 26 " 

Irene" *Arcs 1 3 2 1 2 1 2 1 1 2 4 2 3 9 1 3 11 2 […] 1 25 15 25 17 2 26 13 1 

26 24 2 *Edges Network data ï¬�le 0. 1646 0. 0481 0. 3472 0. 1063 0. 1077

0. 3446 0. 0759 0. 6284 0. 5000 0. 5000 0. 5000 0. 5000 0. 5101 0. 6557 0. 

5000 0. 7478 0. 9241 0. 5000 Figure 3. Partial listing of a network data 

ï¬�le for Pajek. Looking for Social Structure First, the data ï¬�le 

speciï¬�es the number of vertices. Then, each vertex is identiï¬�ed on a 

separate line by a serial number, a textual label [enclosed in quotation 

marks (“ ")] and three real numbers between 0 and 1, which indicate the 

position of the vertex in three-dimensional space if the network is drawn. We

pay more attention to these coordinates in Chapter 2. For now, it sufï¬�ces 

to know that the ï¬�rst number speciï¬�es the horizontal position of a 

vertex (0 is at the left of the screen and 1 at the right) and the second 

number gives the vertical position of a vertex (0 is the top of the screen and 

1 is the bottom). The text label is crucial for identiï¬�cation of vertices, the 
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more so because serial numbers of vertices may change during the analysis. 

The list of vertices is followed by a list of arcs. Each line identiï¬�es an arc 

by the serial number of the sending vertex, followed by the number of the 

receiving vertex and the value of the arc. Just as in graph theory, Pajek 

deï¬�nes a line as a pair of vertices. In Figure 3, the ï¬�rst arc represents 

Ada’s choice (vertex 1) of Louise (vertex 3) as a dining-table partner. Louise 

is Ada’s second choice; Cora is her ï¬�rst choice, which is indicated by the 

second arc. A list of edges is similar to a list of arcs with the exception that 

the order of the two vertices that identify an edge is disregarded in 

computations. In this data ï¬�le, no edges are listed. It is interesting to note

that we can distinguish between the structural data or graph and the 

additional information on vertices and lines in the network data ï¬�le. The 

graph is fully deï¬�ned by the list of vertex numbers and the list of pairs of 

vertices, which deï¬�nes its arcs and edges. This part of the data, which is 

printed in regular typeface in Figure 3, represents the structure of the 

network. The vertex labels, coordinates, and line values (in italics) specify 

the additional properties of vertices and lines that make these data a 

network. Although this information is extremely useful, it is not required: 

Pajek will use vertex numbers as default labels and set line values to 1 if 

they are not speciï¬�ed in the data ï¬�le. In addition, Pajek can use 

several other data formats (e. g., the matrix format), which we do not 

discuss here. They are brieï¬‚ y described in Appendix 1. It is possible to 

generate ready-to-use network ï¬�les from spreadsheets and databases by 

exporting the relevant data in plain text format. For medium or large 

networks, processing the data as a relational database helps data cleaning 

and coding. See Appendix 1 for details. We explain how to create a new 
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network in Section 1. 4. Let us ï¬�rst look at the network of the dining-table 

partners. First, start Pajek by doubleclicking the ï¬�le Pajek. exe on your 

hard disk. The computer will display the Main screen of Pajek (Figure 4). 

From this screen, you can open the dining-table partners network with the 

Read command in the File menu or by clicking the button with an icon of a 

folder under the word Network. In both cases, the usual Windows ï¬�le 

dialog box appears in which you can search and select the ï¬�le Dining-

table_partners. net on your hard disk, provided that you have downloaded 

the example data sets from the book’s Web site. When Pajek reads a 

network, it displays its name in the Network dropdown menu. This menu is a 

list of the networks that are accessible to Pajek. You can open a drop-down 

menu by left-clicking on the button with the triangle at the right. The 

network that you select in the list is shown when 9 File> Network> Read 

Network drop-down menu 10 Exploratory Network Analysis with Pajek Figure 

4. Pajek Main screen. the list is closed (e. g., the network Dining-

table_partners. net in Figure 2). Notice that the number of vertices in the 

network is displayed in parentheses next to the name. The selected network 

is the active network, meaning that any operation you perform on a network 

will use this particular network. For example, if you use the Draw menu now, 

Pajek draws the dining-partners network for you. The Main screen displays 

ï¬�ve more drop-down menus beneath the Network drop-down menu. Each 

of these menus represents a data object in Pajek: partitions, permutations, 

clusters, hierarchies, and vectors. Later chapters will familiarize you with 

these data objects. Note that each object can be opened, saved, or edited 

from the File menu or by using the three icons to the left of a drop-down 

menu (see Section 1. 4). 1. 3. 2 Manipulation In social network analysis, it is 
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often useful to modify a network. For instance, large networks are too big to 

be drawn, so we extract a meaningful part of the network that we inspect 

ï¬�rst. Visualizations work much better for small (some dozens of vertices) 

to medium-sized (some hundreds of vertices) networks than for large 

networks with thousands of vertices. When social networks contain different 

kinds of relations, we may focus on one relation only; for instance, we may 

want to study ï¬�rst choices only in the dining-table partners network. 

Finally, some analytical procedures demand that complex networks with 

loops or multiple lines are reduced to simple graphs ï¬�rst. Application 

Network manipulation is a very powerful tool in social network analysis. In 

this book, we encounter several techniques for modifying a network or 

selecting a subnetwork. Network manipulation always results in a new 

network. In general, many commands in Pajek produce new networks or 

other data objects, which are stored in the drop-down menus, rather than 

graphical or tabular output. Looking for Social Structure 11 Figure 5. Menu 

structure in Pajek. The commands for manipulating networks are accessible 

from menus in the Main screen. The Main screen menus have a clear logic. 

Manipulations that involve one type of data object are listed under a menu 

with the object’s name; for example, the Net menu contains all commands 

that operate on one network and the Nets menu lists operations on two 

networks. Manipulations that need different kinds of objects are listed in the 

Operations menu. When you try to locate a command in Pajek, just consider 

which data objects you want to use. The following example highlights the 

use of menus in Pajek and their notation in this book. Suppose we want to 

change reciprocated choices in the dining-table partners network into edges.

Because this operation concerns one network and no other data objects, we 
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must look for it in the Net menu. If we left-click on the word Net in the upper 

left of the Main screen, a drop-down menu is displayed. Position the cursor 

on the word Transform in the drop-down menu and a new submenu is 

opened with a command to change arcs into edges (Arcsâ†’Edges). Finally, 

we reach the command allowing us to change bidirectional arcs into edges 

and to assign a new line value to the new edge that will replace them (see 

Figure 5). We choose to sum the values of the arcs, knowing that two 

reciprocal ï¬�rst choices will yield an edge value of two, a ï¬�rst choice 

answered by a second choice will produce an edge value of three, and a line 

value of four will result from a reciprocal second choice. In this book, we 

abbreviate this sequence of commands as follows: [Main]Net> Transform> 

Arcsâ†’Edges> Bidirected only> Sum Values The screen or window that 

contains the menu is presented between square brackets and a transition to 

a submenu is indicated by the > symbol. The screen name is speciï¬�ed 

only if the context is ambiguous. The abbreviated command is also displayed

in the margin (see above) for the purpose of quick reference. When the 

command to change arcs into edges is executed, an information box appears

asking whether a new network must be made Menu structure Net> 

Transform> Arcsâ†’Edges> Bidirected only> Sum Values 12 Exploratory 

Network Analysis with Pajek Figure 6. An information box in Pajek. (Figure 6).

If the answer is yes, which we advise, a new network named Bidirected Arcs 

to Edges (SUM) of N1 (26) is added to the Network drop-down menu with a 

serial number of 2. The original network is not changed. Conversely, 

answering no to the question in the information box causes Pajek to change 

the original network. Exercise I Remove all second choices from the original 

network of dining-table partners with the command summarized in the left 
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margin. Which number do you enter in the dialog box headed “ Remove lines

with high values" and why is this command part of the Net menu? (The 

answers to the exercises are listed in Section 1. 9.) Net> Transform> 

Remove> lines with value> higher than 1. 3. 3 Calculation In social network 

analysis, many structural features have been quantiï¬�ed (e. g., an index 

that measures the centrality of a vertex). Some measures pertain to the 

entire network, whereas others summarize the structural position of a 

subnetwork or a single vertex. Calculation outputs a single number in the 

case of a network characteristic and a series of numbers in the case of 

subnetworks and vertices. Exploring network structure by calculation is 

much more concise and precise than visual inspection. However, structural 

indices are sometimes abstract and difï¬�cult to interpret. Therefore, we 

use both visual inspection of a network and calculation of structural indices 

to analyze network structure. Application In Pajek, results of calculations and

other kinds of feedback to the user are automatically reported in a separate 

window that we call the Report screen. If you closed the Report screen or if it

is hidden behind other screens, you can show it again with the Show Report 

Window command in the File menu of Pajek’s Main screen. The Report 

screen displays numeric results that summarize structural features as a 

single number, a frequency distribution, or a cross-tabulation. Calculations 

that assign a value to each vertex are not reported in this screen. They are 

stored as data objects in Pajek, notably as partitions and vectors (see 

Chapter 2). The Report screen displays text but no network Report screen 

File> Show Report Window Looking for Social Structure 13 Figure 7. Report 

screen in Pajek. drawings. The contents of the Report screen can be saved as

a text ï¬�le from its File menu. The Report screen depicted in Figure 7 
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shows the number of vertices, edges, and arcs in the original dining-table 

partners network. This is general information on the network that is provided

by the command Info> Network> General (as you know now, this means the 

General command within the Network submenu of the Info menu). In 

addition to the number of vertices, edges, and arcs, the screen shows the 

number of multiple lines and loops and two indices of network density that 

are explained in Chapter 3. Also, this command displays the number of lines 

requested in the dialog box depicted in Figure 8. Info> Network> General 

Figure 8. Dialog box of Info> Network> General command. 14 Exploratory 

Network Analysis with Pajek In this example, we typed a 5 in the dialog box, 

so the report screen shows the ï¬�ve lines with the highest line values that 

are second choices in the dining-table partners network. In the Report 

screen, each line is described by its rank according to its line value, a pair of 

vertex numbers, the line value, and a pair of vertex labels. Hence, the 

ï¬�rst line in Figure 7 represents the arc from Ada (vertex 1) to Louise 

(vertex 3), which is Ada’s second choice. Exercise II Can you see the number 

of ï¬�rst choices from the listing in Figure 7 and does this number surprise 

you? Which number should you enter in the dialog box depicted in Figure 8 

to get a list of all arcs representing ï¬�rst choices? 1. 3. 4 Visualization The 

human eye is trained in pattern recognition. Therefore, network 

visualizations help to trace and present patterns of ties. In Section 1. 2, we 

presented the sociogram as the ï¬�rst systematic visualization of a social 

network. It was the sociometrists’ main tool to explore and understand the 

structure of ties in human groups. In books on graph theory, visualizations 

are used to illustrate concepts and proofs. Visualizations facilitate an 

intuitive understanding of network concepts, so we use them frequently. Our 
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eyes are easily fooled, however. A network can be drawn in many ways, and 

each drawing stresses different structural features. Therefore, the analyst 

should rely on systematic rather than ad hoc principles for network drawing. 

In general, we should use automatic procedures, which generate an optimal 

layout of the network, when we want to explore network structure. 

Subsequently, we may edit the automatically generated layout manually if 

we want to present it. Some basic principles of network drawing should be 

observed. The most important principle states that the distance between 

vertices should express the strength or number of their ties as closely as 

possible. In a map, the distance between cities matches their geographical 

distance. In psychological charts, spatial proximity of objects usually 

expresses perceived similarity. Because social network analysis focuses on 

relations, a drawing should position vertices according to their ties: vertices 

that are connected should be drawn closer together than vertice 
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